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20  SUMMARY:
21  DetectSynis an unbiased, rapid fluorescent assay that measures changes in relative synapse (pre-
22  and postsynaptic engagement) number across treatments or disease states. This technique
23 utilizes a proximity ligation technique that can be used both in cultured neurons and fixed tissue.
24
25  ABSTRACT:
26  Synapses are the site of communication between neurons. Neuronal circuit strength is related to
27  synaptic density, and the breakdown of synapses is characteristic of disease states like major
28 depressive disorder (MDD) and Alzheimer's disease. Traditional techniques to investigate
29 synapse numbers include genetic expression of fluorescent markers (e.g., green fluorescent
30 protein (GFP)), dyes that fill a neuron (e.g., carbocyanine dye, Dil), and immunofluorescent
31 detection of spine markers (e.g., postsynaptic density 95 (PSD95)). A major caveat to these proxy
32  techniques is that they only identify postsynaptic changes. Yet, a synapse is a connection
33  between a presynaptic terminal and a postsynaptic spine. The gold standard for measuring
34 synapse formation/elimination requires time-consuming electron microscopy or array
35 tomography techniques. These techniques require specialized training and costly equipment.
36  Further, only a limited number of neurons can be assessed and are used to represent changes to
37 an entire brain region. DetectSyn is a rapid fluorescent technique that identifies changes to
38 synapse formation or elimination due to a disease state or drug activity. DetectSyn utilizes a rapid
39  proximity ligation assay to detect juxtaposed pre- and postsynaptic proteins and standard
40 fluorescent microscopy, a technique readily available to most laboratories. Fluorescent detection
41  of the resulting puncta allows for quick and unbiased analysis of experiments. DetectSyn provides
42  more representative results than electron microscopy because larger areas can be analyzed than
43  a limited number of fluorescent neurons. Moreover, DetectSyn works for in vitro cultured
44  neurons and fixed tissue slices. Finally, a method is provided to analyze the data collected from
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this technique. Overall, DetectSyn offers a procedure for detecting relative changes in synapse
density across treatments or disease states and is more accessible than traditional techniques.

INTRODUCTION:

Synapses are the fundamental unit of communication between neurons!. Many synapses
between neurons within the same regions give rise to circuits that mediate behavior?. Synapses
consist of a presynaptic terminal from one neuron that releases neurotransmitters or
neuropeptides that relay information to postsynaptic receptors of another neuron. The
summation of presynaptic signals determines whether the postsynaptic neuron will fire an action
potential and propagate the message to other neurons.

Synaptopathology, the break down of synapses, arises in diseases and disorders marked by
decreased neural volume, like Alzheimer's disease and major depressive disorder, resulting in
circuits that no longer optimally perform3=. Restoring synapse density likely underlies the
efficacy of potential treatments for these disorders. For example, it was recently demonstrated
that increasing synapses underlies the behavioral efficacy of rapid antidepressants®. To rapidly
screen possible synaptopathology treatments, researchers require techniques that quickly
identify changes to synapse numbers.

Current methodologies are either time-consuming and expensive (electron microscopy, array
tomography), or they only examine postsynaptic changes without incorporating presynaptic
engagement (spine analyses, immunofluorescence/colocalization). Dyes like Dil or fluorescent
proteins like GFP help visualize neurons and characterize postsynaptic spines. However, spine
analysis uses researcher-defined ratios to determine morphology, which can decrease
reproducibility’. Further, how the different spine classes relate to functional synapses is still being
uncovered?®. Spine formation can be transient and may reflect postsynaptic plasticity, but these
spines could be eliminated before stabilizing into a synapse with a presynaptic neuron®.

Colocalization provides a better proxy for synapses than spine analysis because one can
immunostain for presynaptic and postsynaptic proteins. However, synaptic proteins may yield
low colocalization values because the proteins are juxtaposed and may not consistently overlap.
Thus, because the proteins are not wholly superimposed, colocalization techniques may not
accurately measure changes to synapse formation due to this missing information. Finally,
although both electron microscopy (EM) and array tomography provide high-resolution images
of synapses, they are time-consuming. EM further requires specialized equipment, and
researchers are limited to small volumes of tissue for any given experiment. While array
tomography elegantly provides the ability to screen for many proteins on ultrathin sections and
can be combined with EM9, this technique may be too labor-intensive and beyond the scope of
experiments that need to scan rapidly for changes to synapse formation.

DetectSyn is a specific application of the Duolink Proximity Ligation Assay. The PLA assay allows
for the general detection of protein-protein interactions. DetectSyn bridges proxy postsynaptic
measures by amplifying a fluorescent signal emitted by tagged pre- and postsynaptic proteins
within 40 nm of each other. If the synaptic proteins are within 40 nm, as within a synaptic cleft,
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then the secondary antibodies, which contain DNA probes, will hybridize into circular DNA. This
hybridized circular DNA expresses a fluorescent probe, which is then amplified and detected with
standard fluorescent microscopy techniques (see Figure 1). Crucially, unlike EM and array
tomography, this technique does not require specialized equipment and takes about the same
amount of time as standard immunohistochemistry. The accessibility of this technique, thus,
enables investigators outside of research-intensive institutions to participate in
synaptopathology research. Further, this technique can examine changes to synaptic density in
multiple brain regions within a single experiment, offering a more holistic representation of
synaptic changes due to disease or treatment.

PROTOCOL:

Isolation of cells and tissue from animals was in accordance with the National Institutes of
Health's Guide for the Care and Use of Laboratory Animals and approved by the Wake Forest
Institutional Animal Care and Use Committee

NOTE: This protocol is used on samples already treated and fixed per specific experimental
paradigms and requirements. For demonstration purposes, synapse formation due to rapid
antidepressant treatment is used to highlight this synapse detection technique®. Neurons
previously cultured on coverslips, treated, fixed in 4% paraformaldehyde (PFA), and stored in 1x
phosphate-buffered saline (PBS) will be used to highlight the in vitro procedures. Previously sliced
hippocampal tissue (25 um thick) from mice treated, transcardially perfused with ice-cold PBS
and 4% PFA, and then stored in cryoprotectant will be used to highlight the slice procedures.
Please see'''? for more information about how to culture neurons or transcardially perfuse
rodents. See Figure 1 for a graphical representation of this procedure.

[Place Figure 1 here.]
1. Rinse samples

1.1.  Rinse the samples with 500 pL of 1x PBS + 0.75% glycine for 5 min 3 times with gentle
agitation on an orbital shaker to remove residual PFA or cryoprotectant.

2. Block and permeabilize samples

2.1.  Prepare blocking and permeabilization solution (10% normal donkey serum, 0.25% Tween
20) in 1x PBS. Prepare enough to use for blocking, primary, and secondary incubations.

2.2. Tosamples (e.g., coverslips or free-floating slices) in 24 well plates, add 500 uL of blocking
and permeabilization solution. Ensure each well contains a different sample and is appropriately
labeled to prevent samples from being switched.

2.3.  Incubate the samples at room temperature (RT) for 60 min for cultured cells or 2 h for
sliced tissue. Use an orbital shaker for gentle agitation.
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3. Incubate samples in primary antibodies
3.1.  Prepare primary antibodies in blocking buffer:

3.1.1. Prepare Postsynaptic density 95 (PSD95; 1:500, rabbit polyclonal), Synapsinl (1:500,
mouse monoclonal), MAP2 (1:400, chicken polyclonal)

3.1.2. Prepare a negative control aliquot that omits one of the synaptic pairs (e.g., without
PSD95)

3.2. Carefully remove the blocking solution with a plastic Pasteur pipette. Try to remove as
much as possible without disturbing the cells or tearing tissue.

3.3. For cultured cells:

3.3.1. Line a large plastic petri dish with parafilm. Carefully transfer coverslips to the parafilm
using forceps.

3.3.2. Carefully add 60 pL of the primary antibody solution to the top of the coverslips. Make
sure not to spill the primary antibody solution over the side of the coverslip.

3.3.3. To provide humidity and prevent samples from drying out during the incubation period,
add ultrapure water to a smaller Petri dish and carefully arrange the small Petri dish around the
coverslips.

3.3.4. Cover the large Petri dish and incubate cultured cells for 1 h at RT.

3.4. For sliced tissue:

3.4.1. Carefully add 250 pL of the primary antibody solution to free-floating slices in a 24 well
plate.

3.4.2. Cover the plate and incubate the tissue overnight at 4 °C with gentle agitation on an
orbital shaker.

4. Wash samples, then incubate in secondary antibodies
4.1.  Prepare secondary antibodies in the blocking buffer:
4.1.1. Prepare Donkey anti-mouse (1:5), donkey anti-rabbit (1:5), donkey anti-chicken (1:400).

4.1.2. At this step, additional technical controls can be obtained by preparing a secondary
aliquot that omits either the anti-mouse or anti-rabbit secondary.
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4.2.  For cultured cells:
4.2.1. Using forceps, carefully tap off the primary solution from coverslips onto a paper towel

4.2.2. Using forceps, carefully transfer the coverslips back to their original 24 well plate filled
with 500 uL of 1x PBS.

4.3. For sliced tissue:

4.3.1. Carefully remove the primary antibody solution with a plastic Pasteur pipette. Try to
remove as much as possible without tearing tissue.

4.3.2. Add 500 pL of 1x PBS

4.4. Wash the samples for 10 min 3 times in 1x PBS with gentle agitation on an orbital shaker.
During this time, bring all wash buffers to RT.

4.4.1. During this time, change the parafilm in the large Petri dish
4.5.  For cultured cells:
4.5.1. Using forceps, carefully transfer the coverslips back to the parafilmed large Petri dish

4.5.2. Carefully add 40 pL of the secondary antibody solution to the top of the coverslips. Make
sure not to spill the secondary antibody solution over the side of the coverslip.

4.5.3. If needed, add more ultrapure water to a smaller petri dish and carefully arrange the small
petri dish around coverslips.

4.5.4. Cover the large Petri dish
4.6.  Forsliced tissue:

4.6.1. Carefully add 250 pL of the secondary antibody solution to free-floating slices in a 24 well
plate.

4.6.2. Cover the plate
NOTE: From here on, protect samples from light by wrapping the tops of the plates with foil.
4.7. Incubate the samples at 37 °Cfor 1 h

5. Ligation
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5.1.  Mix the ligation stock 1:5 in molecular-grade water.

5.2.  Asin section 4, carefully transfer the coverslips and remove the secondary mix from the
sliced tissue.

5.3.  Wash the samples in 500 uL of wash buffer A

5.3.1. For cultured cells, wash 2 times for 5 min. For sliced tissue, wash 2 times for 10 min. Use
gentle agitation on an orbital shaker for both.

5.3.2. During this time, change the parafilm in the large Petri dish

5.4.  While keeping the ligase on a cold block, dilute the ligase 1:40 in the ligation stock from
step 5.1. Perform this dilution immediately before adding the ligase to the samples.

5.5. As in section 4, remove as much of the wash buffer A as possible from samples before
adding the ligase.

5.6.  For cultured cells: Transfer coverslips back to the parafilmed Petri dish. Add 40 uL of the
ligation mix to coverslips, arrange small water-filled Petri dishes around the coverslips, and cover

the large Petri dish.

5.7.  Forsliced tissue: Add 250 uL of the ligation mix from Step 5.4 to each well and cover the
plate.

5.8. Incubate the samples for 30 min at 37 °C.
6. Amplification
6.1. Mix the amplification stock 1:5 in molecular-grade water.

6.2.  As in section 4, carefully transfer the coverslips and remove the ligation mix from the
sliced tissue.

6.3.  Wash samples in 500 pL of wash buffer A

6.3.1. For cultured cells, wash 2 times for 2 min. For sliced tissue, wash 2 times for 10 min. Use
gentle agitation on an orbital shaker for both.

6.3.2. During this time, change the parafilm in the large Petri dish

6.4. Perform this dilution immediately before adding the polymerase to samples. While
keeping the polymerase on a cold block, dilute polymerase
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6.4.1. For cultured cells, dilute polymerase 1:80 in the amplification stock from step 6.1.
6.4.2. For sliced tissue, dilute polymerase 1:40 in the amplification stock from step 6.1.

6.5. Asinstep 4, remove as much of the wash buffer A as possible from samples before adding
the polymerase.

6.6.  For cultured cells: Transfer the coverslips back to the parafilmed Petri dish. Add 40 pL of
the amplification mix from Step 6.4.1 to coverslips, arrange small water-filled Petri dishes around

the coverslips, and cover the large Petri dish. Incubate the samples for 100 min at 37 °C.

6.7. For sliced tissue: Add 250 pL of the amplification mix from Step 6.4.2 to each well and
cover the plate. Incubate the samples for 2 h at 37 °C.

NOTE: During this time, prepare and label slides.
7. Mounting

7.1.  Asin Step 4, carefully transfer the coverslips and remove the amplification mix from the
sliced tissue.

7.2.  Wash the samples in 500 pL of wash buffer B 2 times for 10 min with gentle agitation on
an orbital shaker.

7.3. Wash the samples in 500 uL of 1% wash buffer B for 1 min with gentle agitation on an
orbital shaker.

7.4.  For cultured cells:

7.4.1. Drop 3 plL of mounting media onto a slide

7.4.2. Tap off excess wash buffer from the coverslip and then place the coverslip (with cells
facing down) into the mounting media. Seal the sides with a small amount of clear nail polish to
seal the coverslip in place.

7.5.  Forsliced tissue:

7.5.1. Carefully transfer a tissue slice to the prepared slide and arrange it, so the slice is lying
flat. Drop between 5-10 pL of mounting media (amount will depend on the size of the slice) onto

tissue slice

7.5.2. Carefully place a glass coverslip over tissue slice and seal with a small amount of clear nail
polish along the edge to seal the coverslip in place.
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7.6.  Wait at least 15 min before analyzing under the microscope, or store at -20 °C.
8. Obtain digital images with a confocal microscope.

8.1.1. Optimize the acquisition settings (e.g., laser power, gain, offset) across samples from all
treatments. Ensure that the optimization includes decreasing background noise and enhancing
the signal without oversaturating the intensity of the fluorescent signals. Once settings are
determined, apply the same acquisition settings across all images obtained.

NOTE: The following acquisition details can be used with a Nikon A1 confocal microscope and the
Nikon NIS AR Elements software.

8.1.2. Set the slide with sample on the stage and find the focal plane for the sample using DAPI
through the eyepiece.

8.1.3. Turn off the eye port by clicking on Eye port and choose an optical configuration button
to adjust the settings.

8.1.4. Adjust the gain, offset, and laser power for each fluorescent channel to decrease
background noise and enhance the fluorescent signal. Make sure the fluorescent signal does not
become oversaturated as mentioned in steps 8.1.5-8.1.6.

8.1.5. Monitor oversaturation using a pseudocolor for the fluorescent signal. At the bottom of
the live image, right-click the tab labeled with the fluorescent channel currently being used.

8.1.6. Next, choose Channel Coloring and pick a pseudocolor like Rainbow Dark to visualize the
fluorescence intensity in a heat-map-like pseudocolor. In Rainbow Dark, cooler colors indicate
less fluorescent intensity, and hotter colors indicate more fluorescent intensity.

8.1.7. Once all fluorescent channels are optimized, right-click on the optical configuration
button previously chosen and choose Assign Current Camera Setting for this button.

8.1.8. Verify that the chosen settings are sufficient for a random sample from each treatment
group. If the chosen settings oversaturate any of these samples, repeat step 8.1.4 to eliminate
the oversaturation.

8.1.9. For cultured neurons, follow steps 8.1.10-8.1.16.

8.1.10. Using the eye-port, search for a neuron with dendrites that have minimal overlap with
other dendrites.

8.1.11. Turn off the eye port and use the DAPI channel to visualize the cell body of the chosen
neuron. Double-click on the center of the soma to center the neuron in the middle of the field of
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view.

8.1.12. Using the MAP2 channel, find the best plane of focus for the MAP2 signal with live
scanning.

8.1.13. Under the ND Acquisition tab, click on Save to File and choose a file to save the image
into under Browse. Then, input the filename.

8.1.14. Under the Z tab, select the Symmetric Mode Defined by Range option. Set the focus to
the best MAP2 plane and click on the Relative button to set this focal plane as the middle of the
z-stack.

8.1.15. Set the range to 5 um with 1 um steps, and make sure to check Close Active Shutter
During Z Movement. Under the Wavelength tab, select the name of the optical button with the
previously configured acquisition settings under Optical Conf. Then, click on Run Now.

8.1.16. Repeat steps 8.1.10-8.1.15for about 10 neurons per coverslip/treatment.

8.1.17. For sliced tissue, follow steps 8.1.18—8.1.22

8.1.18. Using the eye-port, search for the region of interest. For example, locate CA1l of the
hippocampus.

8.1.19. Turn off the eye-port and use the MAP2 channel to find the best plane of focus for the
MAP2 signal with live scanning.

8.1.20. Under the Acquire menu, choose Scan Large Image. Next, select the optical button's
name with the previously configured acquisition settings under the Capturing panel from the
panel that opens. Also, ensure to select the correct objective in this panel.

8.1.21. Under the Area panel and the eyepiece, use the arrow keys to set the boundaries of the
region of interest. Next, click on Save Large Image to File and create a save path filename for the
image.

8.1.22. Under the Setup panel, make sure Multichannel Capture is checked, and then choose the
name of the optical button with the previously configured acquisition settings under Optical
Conf.

NOTE: A z-stack for a large image is possible but will increase the scan time.

9. Analysis

9.1.1. Similar to acquisition settings, use samples from all treatments to optimize threshold
settings. Ensure that the threshold optimization focuses on decreasing background noise and
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enhancing the signal without oversaturating the intensity of the fluorescent signals. Once these
settings are determined, apply the same threshold settings across all images used for analysis as
described in steps 9.1.2-9.1.3.

9.1.2. In Imagel, the threshold option is located under the menu Image > Adjust > Threshold.
Choose the Dark Background option if the image has a dark background.

9.1.3. Next, adjust the upper and lower bounds of the threshold per previously determined
optimized threshold settings, then click on Apply.

9.1.4. For cultured cells, use the MAP2 channel and a freehand region of interest (ROI) tool to
draw an ROI for each neuron, including dendrites and soma. For sliced tissue, draw a freehand
ROI within the slice image that encapsulates the area of interest (e.g., stratum radiatum of the
CA1 within the hippocampus).

9.1.5. Obtain the area of the ROI. In Imagel), measure the area under the menu Analyze >
Measure.

9.1.6. Detect the number of puncta within each ROI using an automatic detection tool like
Particle Analysis in Image) following steps 9.1.7-9.1.9.

9.1.7. Find the Particle Analysis option under the menu Analyze > Analyze Particles. First, define
the puncta size diameter, typically 0.1-3 um?.

9.1.8. Next, choose the Overlay Masks option from the Show drop-down menu and check the
Display Results option. Then, click on OK.

9.1.9. If puncta are not detected with the diameter range chosen, adjust the range until all
puncta are detected with this analysis. Make sure to use the same Particle Analysis settings for

all images.

9.1.10. Divide the number of puncta by the area of an individual region of interest by following
steps 9.1.11-9.1.13.

9.1.11. Copy and paste the results for each image from the Results pop-up from Imagel into a
spreadsheet.

9.1.12. First, identify which file and sample the data were obtained from. Then, divide the area
of the ROI by the number of puncta.

9.1.13. Then, clear the data from the Results pop-up, and repeat steps 9.1.2-9.1.12.

9.1.14. Normalize results to control samples: Average the results (number of puncta/ROI area)
for the control samples. Then, divide the obtained results of all samples by the average of the
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control to obtain the normalized results. The new average of the control samples should be equal
to 1.

REPRESENTATIVE RESULTS:

Data modified from Heaney et al.® are presented to demonstrate an experiment where increased
synapse formation is expected (please see ® for more information and a more in-depth discussion
of the mechanism). Previously, it was demonstrated that rapid antidepressants require activation
of the inhibitory metabotropic receptor, GABAB (gamma-aminobutyric acid subtype B), to be
effective®. Further, previous data indicated that rapid antidepressants increase postsynaptic
markers'#; thus, DetectSyn was used to test the hypothesis that rapid antidepressants increase
synapse numbers to be effective.

In cultured neurons, four conditions are tested. First, in the top panel of Figure 2A, cultured
neurons were treated with the vehicle under the same conditions as the experimental control.
However, the PSD95 primary antibody is omitted to provide a technical control for the DetectSyn
assay (see Figure 1 for how each component contributes to the signal). Next, in the Control panel,
neurons again are treated with the vehicle but receive both PSD95 and Synapsinl primaries. Next,
cultured neurons are treated only with the rapid antidepressant Ro-25-6981 (Ro) or Ro plus the
GABAB agonist, baclofen (Bac). As previously demonstrated'3, both the rapid antidepressant Ro-
25-6981 and the GABAB agonist baclofen are required for the in vitro efficacy of Ro-25-6981.
Thus, an increase in synapse formation is demonstrated by an increase in white puncta (Figure
2A ). Without baclofen, no increase in synapse formation in vitro is seen.

In vivo, basal GABA levels are sufficient for the rapid antidepressant to work?*3, so only the rapid
antidepressant Ro-25-6981 is administered via intraperitoneal injection to mice (Figure 2B). The
left panel of Fig. 2B represents another technical control for the DetectSyn assay. Hippocampal
tissue from a saline-treated mouse was probed with both primaries for PSD95 and Synapsinl, but
one of the secondaries was omitted. An increase in synapse formation due to treatment with the
rapid antidepressant Ro-25-6981 compared to saline-treated mice is demonstrated in the middle
and right panels of Figure 2B.

Representative images for technical controls in vitro and ex vivo are shown. In Figure 2A, one of
the primaries for the synaptic pairs is omitted (i.e., PSD95), and in Figure 2B, one of the
secondaries is omitted. While some puncta appear in the technical control images, they are
generally not the same size, as demonstrated by the white speck in the top panel of Figure 2A
compared to the large puncta in the other panels. Further, these puncta are not in the same
location as the puncta quantified, as demonstrated by some puncta appearing within the soma
of the technical control in Figure 2B. Typically, non-specific puncta occur within the nuclei,
perhaps due to the presence of DNA.

To analyze the representative results in Figure 2A, dendrites (visualized by MAP2 staining and
represented here in a grey outline) were traced using a freehand drawing tool to create regions
of interest (ROIs). First, the area of the MAP2 ROIs was obtained using the NIS Elements function,
ROI Data under the Automated Measurement Results tab. Next, puncta were detected using the
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Thresholding function in NIS Elements. This function creates a binary mask of objects that fall
within a defined intensity threshold. Then, the number of binary objects within the MAP2 ROIs
were detected using the NIS Elements function, Binary in ROIl, under the Automated
Measurement Results tab. The data presented in the graph to the right of Figure 2A are the
normalized values of the puncta divided by the area of the ROI.

To analyze the representative results in Figure 2B, the stratum radiatum of the CA1 was traced
using a freehand drawing tool to create an ROI. First, the area of the ROl was obtained using the
ROI data function, as described in the paragraph above. Next, puncta were detected using the
Spot Detection — Bright Spots function, located under the Binary menu. Next, the diameter and
contrast values were chosen based on visual inspection of multiple slices from all treatments.
Once these values were decided, they were applied uniformly across all analyzed images. The
Spot Detection function creates binary masks of objects within the defined diameter and
contrast parameters set. Then, the number of binary objects within the MAP2 ROIs were
detected using the NIS Elements function, Binary in ROI, under the Automated Measurement
Results tab. The data presented in the graph to the right of Figure 2B are the normalized values
of the puncta divided by the area of the ROI.

FIGURE AND TABLE LEGENDS:

Figure 1: Graphical representation of DetectSyn assay. After permeabilizing cell membranes,
primary antibodies for Synapsinl and PSD95 bind to these synaptic proteins. Secondaries with
oligonucleotide tags then bind to the primary antibodies. If Synapsinl and PSD95 are within 40
nm, as at a synapse, then the oligonucleotides interact, and a fluorescent tag is amplified. This
fluorescent signal can then be imaged via standard microscopy and analyzed.

Figure 2: Detection of synapses using DetectSyn assay. White puncta represent synapses
detected with DetectSyn PSD95-Synapsinl proximity ligation assay (yellow arrowheads) in (A) in
vitro cultured primary hippocampal neurons and (B) ex vivo CA1 stratum radiatum. In (A), the
grey outline represents MAP2 staining. In (A), the top panel labeled PLA control represents
samples treated with only vehicle, like the Control. However, the PSD95 primary was not included
in the reaction. In the final two panels, neurons were treated with the rapid antidepressant Ro-
25-6981 (Ro, 10 uM) or Ro plus the GABAB agonist baclofen (Bac, 50 uM) for 90 min. The
increased number of puncta (identified with yellow arrowheads) indicates that in vitro, synapse
formation only increases when the rapid antidepressant Ro-25-6981 is administered with the
GABAB agonist. In (B), green represents dendrites stained with MAP2, and blue represents nuclei
stained with DAPI. Single dendrites, outlined in yellow rectangles in the merged images, are
isolated beneath representative images to demonstrate that puncta localize to dendrites.
Animals were treated with Ro-25-6981 (10 mg/kg), and tissue was collected 45 min after
treatment. The increased number of puncta (identified by yellow arrowheads) indicates that in
vivo, the number of synapses increases with basal GABA signaling and the rapid antidepressant
Ro-25-6981. Quantification of representative results is represented by the bar graphs and
indicates the average number of DetectSyn puncta divided by MAP2 area. Results are normalized
to the experimental control. Images were obtained using a Nikon Alplus confocal microscope.
Scale bars = (A) 10 um; (B, top) 50 um; (B, bottom) 5 um. Bars represent the mean +/- standard
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error of the mean. Results analyzed by one-way ANOVA: * p < 0.05, ** p < 0.01, *** p < 0.001,
**** b <0.0001 by post-hoc analysis. The figure has been modified from Heaney et al.®.

DISCUSSION:

DetectSyn is a rapid assay that uses a proximity ligation assay to detect proteins within 40 nm of
each other, which allows for the detection of synapse formation. This technique improves current
fluorescent assays, which serve only as proxy measurements for synapse formation. DetectSyn
detects quantifiable changes in synaptic proteins localized within 40 nm, i.e., within the synaptic
cleft, of each other. Further, DetectSyn is more cost-effective and takes less time than
techniques, like electron microscopy and array tomography, designed to measure synapses and
classically designated as gold standard techniques.

DetectSyn is a highly customizable technique. Any synaptic pair can be used to identify the
formation of specific types of synapses, as long as the protein pair reside within 40 nm of each
other. While this exciting technique has many applications, one must take care to validate
antibodies, including optimal blocking and primary incubation conditions, and continue to
support their results using other methods like immunofluorescence. It is suggested to perform
these supporting experiments in separate experiments that do not utilize DetectSyn to decrease
antibody binding competition (e.g., using goat anti-PSD95 and mouse anti-PSD95 in the same
experiment may reduce binding due to competition). Additionally, take care to choose primary
antibodies raised in different hosts—for example, goat anti-PSD95 and rabbit anti-Synapsin1. If
the same host is used for both primaries, the secondary probes will not discriminate between the
two primaries.

Further, because proximity ligation has an amplification step, there is limited information one
can draw from the resulting puncta. For instance, different sized puncta are observed (evident in
Figure 2B), suggesting a change in synapse size or multiple synapses recruited to the same area.
However, even though each sample within an experiment undergoes the same conditions, the
amplification step makes it difficult to draw these conclusions categorically.

Finally, critical steps for this protocol include ensuring the ligase and polymerase remain on an
ice block and are added as quickly as possible to samples. Additionally, including technical
controls will help identify where non-specific puncta may appear in a given experiment. For
example, as seen in Figure 2B, puncta within nuclei are seen in technical controls. Thus, it is
crucial to include negative or technical controls to ensure that the signal detected in experimental
samples is greater than that seen in these controls. Typically, these technical controls are
obtained by omitting one of the primary or secondary pairs. Finally, ensure incubation
temperatures are at 37 °C starting at the secondary step.

Importantly, DetectSyn provides an accessible way for almost any laboratory with access to a
standard fluorescent microscope, regardless of technical experience, to study

synaptopathologies.
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Rebuttal Letter Click here to access/download;Rebuttal Letter;response to
reviewers.docx

We want to thank the Editor and Reviewers for their careful consideration of this manuscript. We
feel that by addressing the Editor’s and Reviewers’ keen comments and concerns, we have
significantly strengthened and clarified the manuscript. In what follows, italicized text
corresponds to the Editor’s and Reviewer’s comments, and normal typeface corresponds to our
replies and changes to the manuscript.

Editorial comments:

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are
no spelling or grammar issues.

We thank the Editor for their comments. We have proofread the manuscript for spelling and
grammatical issues.

2. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" etc.).

We have removed personal pronouns from the text.

3. JOVE cannot publish manuscripts containing commercial language. Please remove all
commercial language from your manuscript and use generic terms instead. All commercial
products should be sufficiently referenced in the Table of Materials. For example: Duolink,
Nikon Alplus, etc.

As much as possible, we have removed commercial language.

4. Use Sl units as much as possible and abbreviate all units: L, mL, pL, cm, kg, etc. Use h, min,
s, for hour, minute, second.

We have verified the use of SI units throughout the manuscript.

5. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" etc.).

We have removed personal pronouns from the text.

6. Please note that your protocol will be used to generate the script for the video and must
contain everything that you would like shown in the video. Please add more details to your
protocol steps. Please ensure you answer the “how” question, i.e., how is the step performed?
Alternatively, add references to published material specifying how to perform the protocol
action. Please add more specific details (e.g. button clicks for software actions, numerical values
for settings, etc) to your protocol steps. There should be enough detail in each step to supplement
the actions seen in the video so that viewers can easily replicate the protocol.
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We thank the Editor for their comments. We have updated the steps to be more detailed.

7. Step 2.2: Were the coverslips and tissue slices placed in the same well or different wells?

We have updated Step 2.2 to reflect samples from individual treatments should be kept separate.
8. Step 3.3.4: What is the rationale for using the water filled Petri dish? Is it kept for
humidification? Please describe in 1-2 lines.

We have updated Step 3.3.4 to reflect the purpose of this step.

9. Step 3.3.5: Do the coverslips have adhered cells on them? If yes, please specify this. If not,
please mention at what step were the cells added.

Step 3.3.5 has been updated to be clearer. We also mention in the NOTE before the beginning of
the protocol that coverslips have cells adhered.

10. Step 4.2.1: How was the primary solution tapped off?

We have updated Step 4.2.1. to reflect how the solution is tapped off.

11. Step 4.2.2, 4.3.2: What was the concentration of PBS+glycine used.

Steps 4.2.2 and 4.3.2 have been updated to include the concentration of PBS and glycine used.

12. Step 7.4.1, 7.5.2: What was the concentration of DAPI used?

For these steps, DAPI is included in the mounting media and we were unable to find the
concentration on the manufacturer’s website. These steps were also updated to remove
commercial name of the mounting media.

13. Step 7.7: How were the slides set up for imaging? How were the images acquired? Please
elaborate the steps for acquiring images. Please mention all the steps that are necessary to
execute the action item. If this step needs to be filmed, please make sure to provide all the details
such as “click this”, “select that”, “observe this”, etc. Please provide details so a reader may
replicate your analysis including buttons clicked, inputs, screenshots, etc. Please keep in mind
that software steps without a graphical user interface (GUI) cannot be filmed.



We have significantly elaborated on Step 7.7 to reflect how we obtain images.

14. Step 8: Did the regions of interest have a fixed shape or size or were they drawn using the
free-hand tool? How were the puncta identified? Was it done manually? How were they
counted? Manually or using the analysis system program? How was the area of region of
interest calculated? How was the normalization done? Please provide all details necessary to
perform the analysis. Alternatively, add references to published material specifying how to
perform the protocol action. Readers of all levels of experience and expertise should be able to
follow your protocol.

We have significantly elaborated on Step 8 to reflect the analysis process.

15. Please include a single line space between all the steps and sub-steps. Please highlight up to
3 pages of the Protocol (including headings and spacing) that identifies the essential steps of the
protocol for the video, i.e., the steps that should be visualized to tell the most cohesive story of
the Protocol. Remember that non-highlighted Protocol steps will remain in the manuscript, and
therefore will still be available to the reader.

We have updated the text to include a single line space between steps and sub-steps. We have
highlighted the essential steps to be recorded.

16. Please obtain explicit copyright permission to reuse any figures from a previous publication.
Explicit permission can be expressed in the form of a letter from the editor or a link to the
editorial policy that allows re-prints. Please upload this information as a .doc or .docx file to
your Editorial Manager account. The Figure must be cited appropriately in the Figure Legend,
i.e. “This figure has been modified from [citation].”

The modified figure was modified from an open access article. Reprint policy for the article is
found at the following links and will also be uploaded in a separate file upon resubmission. The
figure is also cited appropriately in the figure legend.

https://www.nature.com/articles/s41380-020-0097 7-z#rightslink

https://creativecommons.org/licenses/by/4.0/

https://s100.copyright.com/AppDispatchServlet?title=Role%200f%20FMRP%20in%?20rapid%?2
Oantidepressant%20effects%20and%20synapse%20regulation&author=Chelcie%20F.%20Heane
y%20et%20al&contentID=10.1038%2Fs41380-020-00977-
z&copyright=The%20Author%28s%29&publication=1359-4184&publicationDate=2021-01-
12&publisherName=SpringerNature&orderBeanReset=true&0a=CC%20BY

17. Please ensure that the Representative Results section explains the results in the context of the


https://www.nature.com/articles/s41380-020-00977-z#rightslink

technique you have described, e.g., how do these results show the technique, suggestions about
how to analyze the outcome, etc. The paragraph text should refer to all of the figures. Data from
both successful and sub-optimal experiments can be included.

We have significantly updated the representative results section to include more information

about how the representative results show the technique. We also confirmed the text refers to all
of the figures.

18. Please ensure that all the essentials (chemicals, reagents, consumables, equipment, etc.) used
in this study are included in the Table of Materials.

We have updated the Table of Materials to include all essential materials.

Reviewers' comments:

Reviewer #1:

Manuscript Summary:

This is well written protocol manuscript that describes a procedure for performing synapse
detection using proximity ligase assay to identify pre- and postsynaptic elements within 40 nm of
each other. The authors present this as an excellent compromise between the "gold standard”
electron microscopy or array tomography (which are expensive) and postsynaptic spine
detection or staining for spine proteins (which can have a high false detection rate). The
explanations are clear and procedure is described in sufficient detail to follow. I have only a few
comments.

We thank Reviewer 1 for their support of our manuscript and procedures.

Major Concerns:
The procedure does require two steps of incubation at 37C. Not every lab has access to an
incubator. Would a water bath be a possible alternative?

A water bath may not be the best alternative because of the instability of water, the risk of
diluting reagents and disrupting/contaminating samples with the bath water. However, it is
conceivable to create a humidity chamber using a water bath and clipping a reusable plastic
container to the side of the water bath for stability. We have updated our Table of Materials to
include an incubator.

Minor Concerns:

The authors make a one sentence comparison of their DetectSyn approach to standard
immunohistochemistry double labeling pre- and postsynaptic proteins with colocalization (line
82-83). The authors should provide some additional details about why standard colocalization is
not sufficient.



We thank the Reviewer for their comment. We have added more information about why standard
colocalization is not sufficient from lines 79-82:

However, synaptic proteins may yield low colocalization values because the proteins are
juxtaposed and may not consistently overlap. Thus, because the proteins are not wholly
superimposed, colocalization techniques may not accurately measure changes to synapse
formation due to this missing information.

What is the purpose of the MAP2 antibody?

Here, we use MAP?2 to identify dendrites, our region of interest. This marker can be swapped out
depending on varying experimental needs. We have updated our text to reflect the purpose of
MAP2.

What is the purpose of 0.75% glycine n the initial rinse from fixative and/or cryoprotectant.

We use 0.75% glycine in the initial PBS rinse to remove trace formaldehyde from the samples,
and to decrease background noise. We have updated our text to reflect the purpose of the glycine
in the PBS wash.

Reviewer #2:
Manuscript Summary:
Review of Jove 63139

The work is of potential interest but is totally missing an important explanation of the technique.
| had to look on the Sigma web site searching for DuoLink before I could figure out what they
were talking about (also guided by their Fig. 1). In what way is their explanation different than
what one gets from the Sigma web site?

We thank Reviewer 2 for their comments. We have updated the manuscript to include a more
detailed protocol for analysis. Further, we provide information on how to use this application for
synapse detection and how to use the application in slice tissue, which is not provided on the
Sigma website. We also thank Reviewer 2 for their comments about Figure 1, which indicated
this figure was not as helpful as we intended. Thus, we also updated our figure to explain the
technique more clearly.

The reviewers need to have a paragraph or two discussing what DuoLink Proximity Ligation
Assay is and what is unique about their application. (The web-site Olink.com has many
neuroscience applications.) | presume they are using ligase and rolling circle amplification; how
much amplification do they achieve?



We thank the Reviewer for their comments. We have updated our last introduction paragraph to
include a discussion of the Duolink PLA and how our application is unique.

Figure 2 is their only data which they actually show, but I find the explanation awfully short.
Figure 2A, left-hand-side, | don't really know what the figure means—the grey lines in the PLA
control? How are the number of spots in the control vs Ro mean? Fig 2B. : what is the negative
control vs Control?

We thank the Reviewer for their comments and concerns. We have significantly updated our
legend and representative results to more thoroughly explain our results.

Major Concerns:
They don't bother to explain their technique! How is this different than what one can get from

Sigma web link?

We have included more information about the technique and the benefits of using this
application of the Duolink technique. Further, we provide a detailed explanation of how to
analyze the results obtained using cultured neurons or sliced tissue, which is not available on the
Sigma website.
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